Getting Started
Your Guide to Social Security Analyzer 2.1 Software
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Welcome to the Social Security Analyzer! We’ve designed our tool to work for couples, singles,
divorcees, widows and widowers in creating a Social Security retirement benefit claiming strategy that is
personalized for your client’s scenario. You can also use the tool when one member of a couple has
already begun benefits sub-optimally to create a strategy for the second to claim benefits. In addition,
the tool can be used for clients who are subject to the Windfall Elimination Provision or Government
Pension Offset, and for those approaching retirement who have minor children in their care. If you have
purchased the Analyzer Plus or the Premier subscription, you will have additional features and
functionalities at your fingertips, including the option of using our tool to run custom analyses for your
clients, access to strategies based on client goals, additional calculators to determine benefits or taxed
amounts, and more.

WHAT WILL YOU FIND IN THIS GUIDE?
This guide is designed to get you up to speed quickly on the most used features of our software. It
includes information about the following:
Logging into the software
Entering client information
Navigating the home page
Viewing and interpreting the most common screen views
Entering a custom strategy
Frequently asked questions

While our software includes many more features and analysis options than are addressed in this guide,
the instructions herein will provide you with the information needed to begin working with clients. In
addition to this guide, you will find more user helps within the software. Additionally, we regularly
update and add features to our software, and this user guide may not reflect the most current features
and user experience. However, the basic functionality will likely be the same as or similar to that which
is described in this guide.
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WHAT INFORMATION WILL YOU NEED TO USE OUR SOFTWARE?
Regardless of the level of your subscription, you will need the following information for each client in
order to use our software:
1. Name, date of birth gender, marital status, and estimated life expectancy.
2. Primary Insurance Amount (PIA) – also known as the full retirement benefit; this is the monthly
benefit if claimed at full retirement age. This can be found on your client’s Social Security
Statement.
3. If the client has a non-covered pension from a job where Social Security taxes were not withheld
from earnings, you will need their earnings history (or adjusted PIA), pension growth rate,
pension start date, and pension amount.
4. If one member of a couple has begun benefits, you’ll need the start date, current benefit
amount, and benefit type (retirement, spousal, or disability). NOTE: The software is not
designed to provide a solution when both members of a couple have begun benefits. In most
situations, their options are few. For assistance with these cases, Premier users should contact
our helpdesk.
5. If there are minor children at the time of retirement, you’ll need the child’s name, date of birth
and expected high school graduation date.
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LOGGING INTO YOUR SOFTWARE
To begin, log on to our software at www.SSAnalyzer.com. To enter the advisor tool, click the “Login”
button on the top right of the screen. For login assistance, contact us at
help@SocialSecuritySolutions.com or 866-762-7526, extension 20.
You will be prompted to enter your login information, including your password. If you forget your
password, click “Forgot Password?” for help.
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A number of features on the SSAnalyzer home screen make navigation through the site simple and easy
to use. Below are screenshots with annotations describing some of the more commonly used
functionalities.

Clients are accessed by selecting the “Advice” option in the top navigation bar. Your client list will
appear on your screen. To change your landing page to something other than your client list, select “Set
Landing Page” from the “Help” menu (indicated with a in the top navigation bar.
1. Select “Client List” to see your full list of clients entered. From this page you can select the
number of clients to be displayed on each screen. In addition, you can search for a particular
client from this screen.
2. Select “New Client” to enter data for a new client.
3. Selecting “Client Search” will also allow you to search by name for a client.
4. To view, edit or delete a client, choose an icon from the “Actions” column.
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ADMINISTRATIVE FUNCTIONS
Administrative functions can be accessed from the “gear” icon near the top right of the screen.
Administrative functions include monitoring account status, accessing reports and calculators.

1. Account Status can be selected to monitor account status, set default variables, and view the
user agreement.
2. Reports is the access point for changing your company logo.
3. Access benefit and tax calculators from the Calculators menu.
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ENTERING CLIENT DATA
Let’s take a look at the features on the initial client data input screen.

To enter a new client, select “New Client” from the home screen menu.
1. Select the relationship status for your client. If you select married, widowed or divorced, the
appropriate data entry boxes will appear below.
2. Enter the client’s estimated spending needs for the purpose of comparing Social Security
benefits to spending needs.
3. Enter an amount of inflation to apply to client spending over time. This is NOT a cost of living
adjustment for Social Security benefits.
4. Enter the client-specific data. For more information about the fields, see below.
5. Select the PIA calculation method. For additional details, see below.
6. The Situation box contains a series of check-boxes to indicate specific factors that impact a
household. For example, if your client is already collecting benefits, you will select the box
“Current Benefits” box to the right of the client name, and the entry fields for benefit amount
and type will unfold. Likewise, if you want to enter the earnings history rather than use the PIA,
simply check “Use Earnings History,” and the entry boxes will appear. To explore the impact of
the Earnings Test, check “Has Future Earnings.”
7. Enter the estimated PIA from a current Social Security statement. If you selected any option in
the Situation box, additional input fields will appear.
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Entering Basic Details about the Client
The primary inputs for every client are:







Client name
Date of birth
Primary Insurance Amount (PIA) – sometimes used interchangeably with “full benefit amount,”
although they are technically not the same. This is the amount that a client will receive at his or
her full retirement age. This can be taken from a Social Security Statement or from
www.SSA.gov/myaccount or calculated from the full earnings history.
Life expectancy
Estimated after-tax spending needs (optional)

If your client is married, you must input the corresponding information for the spouse.
For a client who is a widow/widower you will need the following for additional inputs:



The PIA for the deceased spouse
The date of death for the deceased spouse

For a client who is divorced:


You will need to know the length of the marriage. Client must have been married at least 10
years to his/her former spouse in order to qualify for a spousal benefit.
You will need to enter the date of the divorce. The divorce must have been finalized at least
two years prior to the beginning of benefits.
You will need the PIA for the former spouse. If the client cannot get this amount from the
former spouse, he/she should go to the Social Security Administration with the divorce
decree and the marriage license, and ask for his/her spousal benefit at full retirement age.
Double that amount and enter this product as the former spouse’s PIA.




For a client who is eligible for a pension from work that is not covered by Social Security (noncovered pension, you will need:


Either his/her earnings history from Social Security Administration OR their already-reduced
PIA
The amount of the monthly pension benefit
The date the pension began / will begin
The annual growth rate of the pension if applicable (may be expressed either as an annual
percentage or a monthly dollar amount)
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Entering Non-Covered Pension Details
This step only applies to clients who are eligible for a pension from work not covered by Social Security.
Benefits for these clients will possibly be reduced by the Windfall Elimination Provision (WEP) and/or the
Government Pension Offset (GPO).
NOTE: This does not apply to pensions paid by private employers or if Social Security taxes were
withheld from earnings. Non-covered pensions are from work where Social Security taxes were NOT
withheld from earnings. These are typically federal, state and municipal jobs as well as some education
jobs.

To enter non-covered pension information, select the “Non Covered Pension” box in the Situation area.
Enter the WEP-adjusted PIA. If you do not have the WEP-adjusted PIA from the Social Security
Administration, you will need to select “Past Earnings” in the PIA Calculation Method area and enter the
client’s entire earnings history. Your client can obtain an estimated adjusted PIA at
http://www.socialsecurity.gov/retire2/anyPiaWepjs04.htm.
For each client who is eligible for a non-covered pension, enter the monthly amount of the pension
benefit, the start date of the pension benefit and the growth rate. The growth rate can be expressed as
a percentage or as a flat dollar amount if called for by the pension plan. Additionally, if you enter
pension growth rate, it is important to also enter a COLA for Social Security benefits in the Advanced
Settings box. Otherwise, the pension growth will outpace Social Security benefits, and for some
individuals will result in the software displaying a decline or loss in benefits.
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Entering Primary Insurance Amount, Earnings History, or Current Years Earnings
Our software allows you to choose how you want to enter a client’s benefit amount. You can enter the
client’s PIA as stated on the Social Security Statement, or you can enter the client’s full earnings history.
In addition, it is possible to use a client’s current salary for a very rough estimate of the PIA; however,
we do not recommend using this method. If you use this method, you should disclose to your client that
the PIA estimate is a rough estimate, and direct the client to obtain a current PIA for the purpose of
recalculating benefits in a more accurate anaylsis.
As directed above in the Non-Covered Pension section, if you are entering information with a client who
has a non-covered pension and you do not have a WEP-adjusted PIA from the Social Security
Administration, you must enter the complete earnings history for an accurate PIA estimate.
Depending on the method you select, additional fields will require data entry.
1. Select “Enter Value” to enter an estimated PIA from a current Social Security Statement.
2. Select “Past Earnings” to enter a client’s full earnings history and allow the software to
calculate the estimated PIA.
3. Select “Current Earnings” to enter a client’s current salary and allow the software to provide
a very rough estimate of the PIA. As stated above, we do not recommend using this method
since it will render a very rough estimate of the actual PIA. However, the methodology used
to calculate the rough estimate is similar to that used by the Social Security Administration’s
“Quick Calculator.”
Please note that the Social Security Administration calculates the PIA and “Age 70” benefit amounts
under the assumption that the client will continue to work until drawing benefits, earning the same
amount as in the prior year. If you enter the PIA for your client without future earnings, the benefit
amount in years beyond full retirement age calculated by the SSAnalyzer may be less than shown on the
Social Security Statement.
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NOTE: Do not include earnings from the career in which the client earned a non-covered pension
when Social Security taxes were not withheld. Enter only earnings from which Social Security taxes
were withheld.

Entering Current Benefits

If a client (or spouse) has already started benefits:




Select the benefit type, whether the client’s own retirement benefit, spousal benefit, or disability
benefit.
Enter the date benefits began.
Enter the gross amount of monthly benefit the client is now receiving (do not deduct for
Medicare premiums or taxes that may be withheld from benefit amount).

Entering Future Earnings
The SSAnalyzer gives you the functionality to input future earnings for clients for the purpose of
analyzing the impact of those earnings on Social Security benefits. The Earnings Test is a direct reduction
in benefits for clients who have earned income over a threshold and are receiving benefits prior to full
retirement age.

11

©Social Security Solutions, Inc. All rights reserved.
Revised 07.27.15

To enter Future Earnings, click the Future Earnings box in the Situation area. The Projected Earnings
section will appear and will contain only enough data fields to enter earnings until the year the client
reaches age 70.
NOTE: The client’s monthly benefit will continue to be displayed in the payout tables; however, the
annual and cumulative amounts will be reduced if the earnings test reduces the benefit amount. The
estimated impact of future earnings on a client’s benefits can be viewed by clicking the “Analyze” tab
and 1) selecting “Detailed” from the dropdown “View” menu, or 2) scrolling to the bottom of the screen
and clicking “Monthly Schedule.”

Entering Information for Children’s Benefits
If your client will have minor children in care at the time of retirement, the children and spouse may be eligible
for benefits. Children must be aged 18 or younger and can collect benefits until graduating from high school or
age 19 (unless the child is disabled, in which case benefits may continue). A spouse may be eligible for a
parental benefit until the youngest child turns 16. Benefits in these circumstances will be subject to a family
maximum that can be paid based on one worker’s earnings record.
When entering information about minor children, you must enter the dates of birth and estimated high
school graduation dates in MM/DD/YYYY format.
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USING THE OPTIONAL ANALYSIS SETTINGS
The SSAnalyzer software has a number of optional settings for conducting a deep-dive analysis with
clients. These include:






Application of a discount rate
Application of Cost of Living Adjustments (COLAs)
Average Wage Indexing (AWI)
Longevity planning
Taxation of Social Security benefits

*These features are not available to all users of the software.
NOTE: If you input data in many of these fields, the results will be integrated into the client data. To
view the data in today’s dollars, you’ll need to return to the client details screen and reduce the fields
to zero.

Our firm recommends that you use these advanced features cautiously. In particular, the concepts of
AWI, discount rate and cost of living adjustments can be confusing to clients, and you should be
confident in your own understanding of these before applying them to a client’s scenario.
Discount Rate
A Discount Rate can be used to determine the present value of future benefits. The discount rate takes
into account the time value of money (the idea that money available now is worth more than the same
amount of money available in the future because it could be earning interest) and the risk or uncertainty
of the anticipated future cash flows (which might be less than expected).
Cost of Living Adjustment
Cost of living adjustments (COLA) are applied by the Social Security in most years so that benefits keep
pace with inflation. COLAs are based on increases in the Consumer Price Index for Urban Wage Earners
and Clerical Workers (CPI-W). CPI-Ws are calculated on a monthly basis by the Bureau of Labor Statistics.
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Average Wage Indexing
Cost of living adjustments are applied by the Social Security Administration after age 62 to keep benefits
in line with inflation increases. Average Wage Indexing (AWI) is used prior to age 62 to adjust a client’s
primary insurance amount with inflation, and it is used after age 62 to determine earnings limits under
the earnings test.
AWI will only be applicable when the client is younger than age 62 (for the calculation of the primary
insurance amount, with or without future earnings), or is younger than full retirement age and has
future earnings before full retirement age (for application of the earnings test).
Within the Social Security Analyzer, there are a number of options to select from in indexing past wages.
Of course, you can select “None,” meaning that you do not want Average Wage Indexing to be applied
to a client’s earnings.
The stored assumptions within the software are from the 2012, 2013 and 2014 respective Report of the
Board of Trustees of the OASDI and DI Trust Funds (the Trustees Report). These assumptions vary for
each year in the future for each alternative assumption, until the benefit increases reach their highest
level around the tenth year projected into the future.
Within each set of assumptions, there are three levels of benefit increases: Low, Intermediate and High.
Low assumptions vary for each year in the future until the benefit increases reach 1.8% in about the
tenth year of projection. Intermediate assumptions reach 2.8% in about the 10th year of projection. High
assumptions reach 3.8% in about the tenth year of projection.
If you choose to analyze Social Security income projections under inflation scenarios, we recommend
assuming both Average Wage Index growth and cost of living adjustments.
Using an AWI selection will cause the client’s PIA to be recalculated within the software. In cases where
the client is relatively young with substantial wage growth over time, the PIA might be recalculated to a
high amount that may or may not be accurate after the fact. If you choose to utilize the AWI or other
optional features within the software, you should disclose such facts to your clients.
The report you create for your clients using the SSAnalyzer software will reflect the assumptions you
select for AWI, cost of living adjustments and discount rate. These selections will be disclosed in the
client report disclosure section. Social Security Solutions, Inc. is under no obligation to update the report
calculations at any time and assumes no responsibility should conditions change or unexpected
occurrences happen to affect the analysis in the report after the fact.
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Taxes on Benefits
To determine the percentage of Social Security benefits that are taxable, use the Tax Calculator found
under the Help tab in the navigation bar. For any single year, you can enter a client’s estimated benefits
and all of the income that is included in Modified Adjusted Gross Income to calculate the taxable portion
of benefits. Then, simply transfer the taxable percentage to the box in the Analysis Settings section.
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OVERVIEW TAB
After clicking “Save and View Results,” the tool will display the Primary strategy. The Primary Strategy is
the claiming option that will likely result in the highest cumulative lifetime payout. On the screen you
will see the following:






A text bar containing client name(s), date(s) of birth and primary insurance amount(s).
A cumulative benefit bar graph.
Total cumulative lifetime benefits and maximum monthly benefits.
A table of cumulative benefits.
Step-by-step details of the primary claiming strategy.

Need to edit client data?
Click here.
Plus and Premier subscribers can use
the “Manage Strategies” button to
build custom strategies.
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ANALYZE TAB
The Analyze tab is clickable within the tabbed work area of the software. The Analyze tab will default to
the Primary strategy. You can also view each of the other strategies in this format by selecting another
strategy from the dropdown menu on the left. In addition, on the right side you can select a short,
normal or long life expectancy for a graphic view of benefits.
From the View menu, you can select Basic, Detailed, or Needs Analysis. “Basic” provides a view including
the monthly, annual and cumulative payouts for clients. “Detailed” includes the impact of taxes and the
earnings test on benefits if those fields have been entered for a client. “Needs Analysis” compares
benefits with projected spending. These features are also accessible on the Advanced tab but have been
added to the Analyze tab for easy access. Finally, a table of monthly and annual benefits appears on the
Analyze screen.
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Monthly Schedule View
At the bottom of the Analyze tab is a clickable link to the Monthly Schedule view. This screen displays
the monthly benefit being collected by the client/spouse at any month in time.
In the example below, the monthly details for George and Martha show the following:








In his 66th month, George is collecting a benefit of $2,018.
George’s PIA is $2,018.
The Family Maximum based on George’s earnings is $3,841. (The Family Maximum benefit is the
greatest amount payable to any additional beneficiaries on that person’s earnings history.)
Martha is collecting $800 in her own benefit plus a small spousal benefit in the amount of $128.
Here total benefit is $928.
Martha’s own PIA is $867.
The Family Maximum based on Martha’s earnings is $1,365.
Together George and Martha are collecting $2,946.

In addition, this monthly view is where you can see any deductions taken from benefits due to the
earnings test when a client has not reached full retirement age and is collecting benefits.
In the event a client or client couple has minor children who will be eligible to collect benefits on a
parent’s retirement benefit record, those amounts will be displayed on the monthly view as well.
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COMPARE TAB
The Compare tab allows you to compare two strategies side-by-side. You will see the difference
between the strategy payouts, a graph of cumulative benefits, and a breakeven graph for the strategies.
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STRATEGY LIST TAB
(available only to our Plus and Premier subscribers)
The Strategy List tab provides the detailed claiming instructions for each strategy: Primary, Early, Full
Retirement Age, Delayed, and any custom strategies you have created. In addition, we’ve included
strategies that fulfill common client goals such as maximizing survivor benefits and maximizing
cumulative payout during joint lives. For some clients, you may also see and Alternative 1 or Alternative
2 strategy. These represent strategies that will pay less in cumulative benefits than the Primary strategy
but may be worthy of discussion with your client.

Claiming details for each
strategy appear on the
Strategy List tab.

Click Download to
create a simple
spreadsheet of
cashflows.

To save a “Goal” strategy to your list of strategies for comparison, simply click “Save” and refresh the page
in the URL bar:
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PUBLISH TAB
The Publish tab is where you will create your client reports. For subscribers to our Plus and Premium
levels, you will have additional functionality in printing reports, such as using the full default report
created by Social Security Solutions, Inc., or creating a custom template with segments of our report you
select.

You can choose which
strategies to compare
in the printed report
by selecting them in
the dropdown menus.

Enter optional
personalized Introduction
Text that will appear on
page 2 of your client
report.

Plus and Premier subscribers can use
our standard template or create a
custom template. To create a custom
template, choose by selecting or
deselecting the segments of our
report you want to print. Name your
template and click “Save.”
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If you’ve saved
custom reports, those
can be accessed from
the Report Template
dropdown menu.

ADVANCED TAB
(available only to our Premier subscribers)
The Advanced tab mirrors the Analysis Settings found on the client data entry screen. From this tab, you
can:






Enter or adjust a discount rate to assess the time value of money
Enter or adjust an average Cost of Living Adjustment (COLA)
Alter the +/- years of longevity for your clients
Enter client tax information and see how taxes will impact benefits
Enter earnings before full retirement age and see the impact of earnings on benefits

After entering the data, click “Update” to view results. You will be able to compare three strategies sideby-side from the Advanced tab. NOTE: Any adjustments made on the Advanced tab will update the
client data analysis on the other tabs. This may mean that the Primary claiming strategy will be
different.

Enter optional settings
and click “Update” to
view results.
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ENTERING A CUSTOM STRATEGY
(available only to our Plus and Premier subscribers)
With the Social Security Strategy Analyzer – Premium, you can enter custom strategies to compare sideby-side. To enter custom strategies, click the “Manage Strategies” tab on the Overview, Analyze or
Compare tabs . The custom strategies you enter for a client will be saved only for that client – not for all
of your clients, so you can personalize each strategy (e.g., Bob and Kim’s Early Strategy). NOTE: If the
strategy you enter is not an allowable manner in which to claim benefits, the software will not return an
error message but will instead return the closest matching claiming details that are allowable under the
rules of Social Security.

You can enter multiple custom strategies to
compare. Click “Save” to store the strategy.
You can enter several custom strategies at
the same time without returning to client
details. Click “Close” to return to client
details.

ADDITIONAL FEATURES
The SSAnalyzer has many additional features including:




The patented Social Security Zone™*
The Coordinate tab*
The Invest tab*

These features are not available to all users of the software. Additional information about using the
Social Security Zone™, the Coordinate tab, and the Invest tab can be found in the clickable educational
materials found within the software.
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SPECIAL DISCLOSURE
The calculations within the Social Security Analyzer and all related information is based on Social
Security rules, benefit calculations, and payout promises of existing Social Security policy at the time this
document was created. The purpose of the software and related information is to educate and give
general guidance to help craft a personalized approach to taking Social Security. The Social Security
claiming strategies created by this software will be generated based on information you input. That
information includes estimates of Primary Insurance Amounts, life expectancies, and dates of birth. If
this information you enter, including life expectancy projections, should prove wrong after the fact, then
the primary strategy may not be the best strategy for your client after the fact. You should disclose this
information to your clients and instruct them to analyze and compare our calculations and
recommendations with other scenarios generated by a financial professional before implementing any
strategy. The optimal strategy for a specific client depends, in part, on that client's tradeoff between the
goals of maximizing expected lifetime benefits and minimizing the risk of outliving his or her financial
assets. As such, it is ultimately the responsibility of the client to carefully consider the primary strategy
before adopting it as his, her or their own.
This software and related information should be used only as a general guideline and not as the ultimate
source of information about Social Security claiming strategies. Social Security Solutions, Inc. shall have
neither liability nor responsibility to any person or entity with respect to any loss or damage caused, or
alleged to be caused, directly or indirectly, by information contained in this report.
Social Security Solutions is not affiliated with or endorsed by the Social Security Administration.
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FREQUENTLY ASKED QUESTIONS
1. What information do I need to have when working with a client that has a non-covered pension?
You will need the following information:







Client’s First and Last Names
Birth date (MM/DD/YYYY)
The client’s earnings history from a current Social Security Statement
Month, day and year client is targeting receiving their monthly pension, OR month, day and
year they started their pension.
Monthly gross amount they are receiving from pension OR Monthly gross amount they will
receive from pension.
Average growth rate associated with pension, if applicable.

2. What is the Help desk number I call when I need assistance?
The number is 866-762-7526, Ext. 20. Helpdesk hours are 8:30am – 5:30pm Monday through Friday
central time. You can also email help@socialsecuritysolutions.com
3. How can I change my Password?







Login into your account
Select “Help” from the blue navigation bar on the upper right hand side of screen
Select “Change Password”.
Enter new Password
Confirm new Password
Click on “Change” Password

4. How can I change my Username?





Login into your account
Select “Help” from the blue navigation bar on the upper right hand side of screen then select
“Change Username”.
Enter new Username
Click on “Submit”

5. I am unable to login into website; it is not working. Can you help me?
Please make sure you are logging in at http://www.SSAnalyzer.com. If it is still not working please
call 866-762-7526 Ext. 24 for further assistance.
6. Where can my clients go to get their Social Security data?
Clients can create a free, secure account with the Social Security Administration by going to
https://www.ssa.gov/myaccount.
25

©Social Security Solutions, Inc. All rights reserved.
Revised 07.27.15

7. I purchased the software and need a sales receipt how can I get one?







Login into your account and view the blue navigation bar on the top of the screen.
Click on the “Admin” section.
Select “Account Status”.
You will see your Payment history below.
Click on the “receipt” link.
The receipt will display on screen and you can choose to either “print receipt” or “Download
PDF”.

8. What birth years are associated with the current Full Retirement ages?








1943-1954 = Full Retirement Age of 66
1955 = Full Retirement Age of 66 and 2 months
1956 = Full Retirement Age of 66 and 4 months
1957 = Full Retirement Age of 66 and 6 months
1958 = Full Retirement Age of 66 and 8 months
1959 = Full Retirement Age of 66 and 10 months
1960 or later = Full Retirement Age of 67

26

©Social Security Solutions, Inc. All rights reserved.
Revised 07.27.15

